
[image: ][image: ]United States Department of Agriculture 
US Forest Service
Natural Resource Manager (NRM)
NRM Air v3.0.0 User Guide 
Chapter 5: Air Data Tools

November 2016
[image: NRM-logo-square]
Table of Contents
Introduction	5-3
NRM Workbench	5-3
NRM Air Excel Add-in	5-3
Behind the scene in the NRM Workbench and Add-in	5-3
Helper Database	5-3
Air Water Chemistry Database	5-3
Geographic Extents	5-4
The Air Data Input Process	5-4
NRM Workbench	5-5
Accessing NRM Workbench in Citrix	5-5
Initial Set-Up	5-6
Configuration Setup	5-6
Select Workbench Services	5-7
Using NRM Workbench	5-8
Export Services	5-9
Validate and Load Services	5-13
Move Visit Service	5-17
NRM Air Excel Add-in	5-18
The Air Data Input Process	5-18
NRM Air Excel Add-in Installation	5-18
How to Check the Version of NRM Air Excel Add-in	5-18
Getting Started with the NRM Air Excel Add-in	5-19
Select Trusted Locations	5-19
Activating the NRM Air Excel Add-in	5-22
Link Tables	5-23
Air Add-in Menu Groups	5-23
Lab Data Group	5-24
Analysis Group	5-26
Server Group	5-28
Control Group	5-28
Sample Definition Form	5-28
Navigating Data in the Workbook	5-31
Data Columns	5-31
Sample and Measurements Hide/Show Detail	5-31
Sorting and Filtering Data	5-31
Copy & Paste Data in the Air Add-in Template	5-32


Charting with the Excel Add-in	5-32
Run Chart Set(s)	5-34
Chart Set XML Files	5-34
Additional Information	5-35
FAQ and Troubleshooting	5-35
Processes	5-36





1
NRM Air v3.0.0 User Guide	5-19	Chapter 5: Air Data Tools
[bookmark: _Toc134265112][bookmark: _Toc529923459][bookmark: _Introduction][bookmark: _Toc467311549][bookmark: _Toc182036405]Introduction
[bookmark: _Toc193789210][bookmark: _Toc194127111][bookmark: _Toc192644557][bookmark: _Toc193707175][bookmark: _Toc184009764]While NRM Air allows you to view and enter most field-collected data or source permit data directly, exporting, entering and conducting quality checking and analysis of monitoring lab data is not efficient through the application. To meet this need, NRM created two tools, called the Air Data Tools, that work together to meet these needs:
1. NRM Workbench
2. NRM Air Excel Add-In (and behind-the-scene Microsoft Access database)
[bookmark: _Toc467311550]NRM Workbench
The NRM Workbench is a tool to help you import and export data into and out of the NRM Air database.  There are four functions within the NRM Workbench for maintaining the air water chemistry lab data:
1. Export Template
2. Validate
3. Load
4. Move Visit
[bookmark: _Toc467311551]NRM Air Excel Add-in
The NRM Air Excel Add-in allows you to view and work with exported chemical monitoring data from NRM Air.  The Add-in also has the capability for quality assuring, charting and conducting simple analysis of data.
But, it’s most important purpose may be its role in helping you prepare lab chemistry data from most spreadsheet or database formats provided by analytical labs so you can import the data into NRM Air using the NRM Workbench.
[bookmark: _Toc467311552]Behind the scene in the NRM Workbench and Add-in
The NRM Workbench and Air Excel Add-in use two Access databases for storing and manipulating air data: 1) the “Helper Database,” and 2) the “Air Water Chemistry Database.”
[bookmark: _Toc467311553]Helper Database
The “helper” database does not contain data, but assists the NRM Air Excel Add-in to manipulate and load data into the Air Water Chemistry database. You’ll never open the helper database, it simply works behind the scenes.
In some cases a new helper database will need to be generated, or located if the existing helper database has been deleted or moved.  Generating a helper database will discussed in the Excel Add-in section of this user guide.
[bookmark: _Toc467311554]Air Water Chemistry Database
The Air Water Chemistry database (AirWaterChemistry.mdb) is used for loading and retrieving data with the Excel Add-in and NRM Workbench from the NRM Air database.
Figure 1: NRM Air Geographic Extents
[image: ]
[bookmark: _FME_Server][bookmark: _Geographic_Extents][bookmark: _Toc467311555]Geographic Extents
[bookmark: _Toc383157317]NRM Air is separated into five user groups defined by geographic “extents.”  This map shows the NRM Air Geographic Extents which are based on combined Forest Service regional boundaries.  The Air Data Tools will only allow you to import or manage data for those extents where you have editing roles.  Refer to the Introduction for details on obtaining user group access.
[bookmark: _FME_&_The][bookmark: _Toc467311556]The Air Data Input Process
Instructions to use the NRM Workbench and Excel Add-in are included in this section, but for examples, please see the Processes section at the end of this chapter for specific examples of data flow.
In general, water chemistry lab data is received by the Air team from various labs.  The Air team then uses the NRM Air Excel Add-in to review and examine the lab data to ensure data integrity.
After review, the lab data are ready to be loaded into the NRM Air.  Air uses the NRM Workbench to retrieve and load this data.


[bookmark: _NRM_Workbench][bookmark: _Toc467311557]NRM Workbench
Previous versions of NRM Workbench were installed on each user’s computer.  Now, users access NRM Workbench through Citrix rather than as a desktop application.  If you have Workbench installed on your computer, this version no longer works and needs to be uninstalled. Refer to the NRM Data Tools webpage for uninstall instructions.
[bookmark: _Toc467311558]Accessing NRM Workbench in Citrix
To use NRM Workbench, login to in Citrix using the same username and password you use to login to your computer.
Figure 2: Citrix login screen
[image: ]
When the initial Citrix screen opens, navigate to Main > National Applications > Natural Resource Manager > Tools, shown in Figure 3.
Figure 3: Citrix Tools screen
[image: ]
Then single click on the NRM Workbench icon to access the Workbench, see Figure 4.
Figure 4: NRM Workgroup icon in Citrix
[image: ]
[bookmark: _GoBack]

It may take a couple of minutes for the NRM Workbench interface to open (Figure 5).
Figure 5: NRM Workbench interface
[image: ]
[bookmark: _Toc467311559]Initial Set-Up
[bookmark: _Configuration_Setup][bookmark: _Toc467311560]Configuration Setup
The first time you use NRM Workbench, you’ll need to go through the configuration process which requires you to enter your FS email address, then click OK.
	
	Note
The Database Environment and FME Server Environment drop-downs will be blank.  Select OK when finished.


Figure 6: Initial Configuration Setup window
[image: ]
Figure 7: Reset menu item
[image: ]
Click on Config > Reset.  This time, the Configuration Setup window will already include your email address.  Select Production for both environments, and click OK.  Make sure you are always working in the Production environments.
Figure 8: Completed Configuration Setup
[image: ]
[bookmark: _Toc467311561]Select Workbench Services
The NRM Workbench provides services for several NRM business area applications including Air.
To use the Air Workbench Services, select Config > Select Services to open the Select Workbench Services form.  The first time this is opened and anytime you do a reset, all of the selections will be set to “false.”
Figure 9: Select Workbench Services window
[image: ]
Select “true” to activate the Air Services you intend to use.
Figure 10: Select Workbench Services
[image: ]
Click on OK in the lower left-hand portion of this window to save your options.  This completes the setup of the NRM Workbench.
	
	Note
The Select Services options can be changed at any time by following the steps above.


[bookmark: _Toc467311562]Using NRM Workbench
From the main Workbench window, use the drop-down arrow to “Select the Workbench Service.”  The services available are the ones you’ve already chosen, as shown in Figure 11.
Figure 11: NRM Workbench drop-down list of services
[image: ]
The Workbench is easy to use, simply click on the desired service, fill in the required information for that service, then click the “Run Service” button. Each service is detailed in the following sections.
Workbench also provides service descriptions.  To view the description, first select the service, then click on the “Service Description” button.  A new window will open providing a description of that particular service, as shown in Figure 12.
Figure 12: Service Description window for Export Template
[image: ]
[bookmark: _Export_Template_Services][bookmark: _Export_Services][bookmark: _Toc467311563]Export Services
The Air Export Template service is used to: 1) export water monitoring data from a specific project(s) to use with the NRM Air Excel Add-in for review and simple analysis, or 2) to export a current AirWaterChemistry.mdb Access database (blank template) for population of lab data to be loaded into the centralized NRM Air database.
[bookmark: _Toc451867736][bookmark: _Toc464471582][bookmark: _Toc464631878][bookmark: _Toc466971819][bookmark: _Toc467157339][bookmark: _Toc467307349][bookmark: _Toc467311564]Export Water Monitoring Data
For best performance, export data from a single or small group of monitoring projects at a time.  Select the workbench service “Export Template” from the drop down menu.
Figure 13: NRM Workbench - Export Template
[image: ]
Double click in the blue box to the right of the “Geographic Extent” and select the appropriate extent from the filter form and select OK (see the Geographic Extents section if you are unsure what to select).
Figure 14: NRM Workbench - Geographic Extent Filter Form
[image: ]
To select “Monitoring Project(s),” double-click in the blue text field.  The Monitoring Projects listed will only be those related to the geographic extent you selected.  One or more projects can be selected from the list presented.  Use Ctrl-Click to select more than one project.  Select OK when complete.
Figure 15: NRM Workbench – Monitoring Project Filter Form
[image: ]
If you want only data from some of the monitoring site(s) in the project, double click in the blue text field for Site Project CNs to open the Site Project filter form to choose from the list of monitoring sites used in the Monitoring Project.  Select one or more sites and click OK.
	
	Note
If you do not select any sites (leave this field blank), all sites and data for the Monitoring Project(s) selected will be exported.


Figure 16: NRM Workbench – Site Project CN Filter Form
[image: ]
You can also select data by typing in Hydrologic Unit(s) codes in the Hydrologic Units field.  This can be very useful if working on forest plans or watershed assessments.  After making your optional selections of Project(s), Site(s) and Hydrologic Unit(s), click on Run Service.  Leave the “Delivery Method” set to the default “async”.  The response is displayed below the request section of the window.
After you click Run Service, a window opens for you to select the folder where you want your results.  Remember, you are working in Citrix, not on your own computer, so, although the folders shown include My Documents and folders look like those you are used to seeing on your computer, they are actually in your allocated space in Citrix.  You can either choose to save your output files Citrix (the X drive), on the T drive, or, if you have an external drive attached to your computer, on that external drive.  Navigate to the drives by expanding the Computer folder.  Select the folder, then click OK.
Figure 17:  NRM Workbench – Choose Folder for Output File
[image: ]
A command window will open as NRM workbench runs through the commands to access your data.  It will close automatically when done.
Figure 18:  NRM Workbench – Command Line Window
[image: ]
When the Workbench process is through, you will see the Process Complete window which lists the folder where your output files went as well as the Output filename and log filename.  The date and time is appended to all file outputs.  Click OK to continue.
Figure 19: NRM Workbench – Process Complete
[image: ]
	
	Note
Especially if you are dealing with multiple datasets, it helps to rename your output file to include the name of the dataset.  Do not delete or change the “Air Water Chemistry” part of the name, or the Air Excel Add-in will not be able to read the file.  Workbench automatically puts a date/timestamp on the filename.


[bookmark: _Toc451867737][bookmark: _Toc464471583][bookmark: _Toc464631879][bookmark: _Toc466971820][bookmark: _Toc467157340][bookmark: _Toc467307350][bookmark: _Toc467311565]Export Blank Template
When you are loading a new dataset into NRM Air, the first step is to export a blank template which the Air Excel Add-In uses to import values such as site names and type tables.  To export a blank template of the current NRM Air database, follow the same process as for exporting water monitoring data (above) but leave all fields blank, then click  Run Service.  Your output file and a log file will be automatically saved in the folder you chose.  You may want to rename the file to include the dataset name, but you MUST leave the AirWaterChemistry portion of the name so Workbench can recognize the file. (e.g., AirWaterChemistry_MyDataset_20161113112148.mdb).
[bookmark: _Toc467311566]Validate and Load Services
There are two steps to uploading data in the NRM Air database:
1.  1) “Validate” which does an initial check of the data to be loaded and then generates a report describing what will be inserted and/or updated in NRM Air, and 
2. 2) “Load” which actually inserts and/or updates the data as described in the validate report and then generates a load report describing what it loaded or updated.
The Excel Add-In populates the AirWaterChemistry Access database that you downloaded through the Export Template process (see the Excel Add-in section for detailed instructions).
	
	Warning
The AirWaterChemistry.mdb database can only be accessed through Citrix from an external USB device, the T drive, or your assigned Citrix space (the X drive).  You must copy and paste the Access database with the data to be validated and loaded to NRM Air into one of these locations prior to using the Workbench Services.


[bookmark: _Validate_Service][bookmark: _Toc451867739][bookmark: _Toc464471585][bookmark: _Toc464631881][bookmark: _Toc466971822][bookmark: _Toc467157342][bookmark: _Toc467307352][bookmark: _Toc467311567]Validate Service
To Validate, select the Validate service from the “Select the Workbench Service Menu” in NRM Workbench.  Then, select the “Lab Data File” by double clicking in the adjacent box.  This will open the Citrix input source window (similar to Windows Explorer window).  Navigate to folder on the T drive, external USB drive or your Citrix space on the X drive and select the Access database to be validated, then click Open.
	
	Note
You may get a “File Security” pop-up requesting access to your external USB drive.  Select “Permit all access.”


[bookmark: _Toc383157341]Figure 20: Citrix Input Source Window
[image: ]
It may take a while for the file to load in Citrix, so be patient.  When the input window closes, you’ll see the file name and path in the Lab Data File field in NRM Workbench.
You can then select whether or not to see warnings in the Results. By default, the Report Warnings in Result option is set to “No” in an effort to reduce the output report size.  If you wish to have warnings included in your final report, click “Yes.”  Leave the Delivery Method on the default value of “async”, then click on the “Run Service” button.
Figure 21: NRM Workbench – Validate Service
[image: ]
The Browse for Folder window will open and you will navigate to the folder on the T, external USB drive, or the X drive (Citrix) where you’d like your results saved.  If you want to be able to view the outputs when not signed into Citrix, we recommend using a folder on either the T drive or on an external USB drive attached to your computer (see Browse for folder above for screen captures and details).
The output from this service is an HTML file as well as the log file which can be useful in troubleshooting.  You should always review the report for errors and completeness before invoking the Load service.  Also notice that in the report’s first row of both the Validate and Load workbench services the database environments and lab data source are identified.  If the exported Access database environment doesn’t say Production, don’t proceed.  Go back and use the Config > Reset selection in NRM Workbench and make sure to select Production.
Figure 22: NRM Air Water Chemistry Lab Data, Validate Report (first row)
[image: ]
[bookmark: _Cover_Page_Image]Review the Validate report looking for errors.  Use a Find (Ctrl – F) with the word “error” to find any errors.  The Find function also works well to look for other specific items such as detection limits, and comments.  Scroll through to make sure the Validate report is creating or updating Monitoring Sites, Site Project Records, Visits, Samples, Measurements and Chain of Custody records.
After checking for errors in the Validate report, you should also review it to understand what exactly will occur in the load.  Thinking critically, ask yourself:
· Are the records to be inserted new?
· Do the records being updated exist?
· Are the values of the records being updated correct?
If Sites, Visits, and/or Samples have been created in the Air application prior to loading the data, make sure any data changes are the right ones to make.
The Validate service can be run as many times as needed.  For instance, you may discover data are missing and need to make corrections.  Make the corrections in the Excel Workbook and follow the “Load from Excel” procedure to repopulate the Water Chemistry Access database before initiating the Validate service again.  You will need to copy the updated Access database to the T, external USB, or X drive before reselecting and running the service.  Make sure to review the report from the Validate service each time.
[bookmark: _Load_Service][bookmark: _Toc451867740][bookmark: _Toc464471586][bookmark: _Toc464631882][bookmark: _Toc466971823][bookmark: _Toc467157343]

[bookmark: _Toc467307353][bookmark: _Toc467311568]Load Service
The Load service is identical in procedure to the Validate service and provides a similar HTML report, identifying what records were inserted and updated as well as identifying existing records not requiring any updates.
	
	Warning
There are no roll-back operations available.  Be certain that the Validate report shows your Load will have your intended results.  Mistakes in loading will have to be corrected manually if they are minor, or through the NRM helpdesk accessed through CHD if major.  If errors occur, contact CHD with a request for assistance for NRM Air data tools.


Datasets loaded through the Air Data Tools default to Valid and are therefore “Published” in the NRM Air database unless a Validity Type of something other than “Valid” is individually selected in the sample row in the workbook.  Published data are automatically sent to the FED website on a regular basis and are available on the internet for the public (see Chapter 9 for more on the FED website).  If your data are Published to the FED website, please note that this update occurs on an automatic weekly cycle.  You will likely see it early in the week after you’ve uploaded it if the FED staff were able to do the updates.
	
	Note
Data without a Validity Type of “Valid” are not Published and are therefore not pushed to FED.  If you have data or a dataset that are Valid, but you don’t want it published on FED, go in via NRM Air and make sure the box for Published is unchecked for either the entire Monitoring Project or for the individual visit.


Figure 23:  Publish field on the Monitoring Project form
[image: ]
Figure 24: Publish field on the Monitoring Visit form
[image: ]
Once you Load the data and have scanned the Load report to ensure you got the desired results, view the data in NRM Air to confirm your results.
[bookmark: _Move_Visit_Service][bookmark: _Toc467311569][bookmark: _Toc374362113][bookmark: _Toc383157556][bookmark: _Toc428878521][bookmark: _Toc441483398][bookmark: _Toc441772779][bookmark: _Toc442790521][bookmark: _Toc443481130]Move Visit Service
This service will move one Visit (and all the associated data – samples, measurements, etc.) from one Monitoring Site to another within the same Monitoring Project.  As with the other Workbench Services, after selecting the Move Visit service from the drop-down menu at the top, select the appropriate option for each field:
· Geographic extent
· Monitoring Project
· Source Site Project (select the site you want to move the Visit from).
· Visit CN (select the visit date to be moved).
· Source Site Project (select the site you want to move the visit to).
The rest of the process is the same as the other Workbench services.  Select “Run Service” to receive a report of the results stored in the folder on your T, X, or external USB drive.
Figure 25: NRM Workbench – Move Visit
[image: ]


[bookmark: _Abstract][bookmark: _NRM_Air_Excel][bookmark: _Toc467311570]NRM Air Excel Add-in
This Add-in will work in Excel 2010 or higher version workbooks.  The interface is implemented on a new tab in the Excel menu at the top of the window.
Both Microsoft Excel and Microsoft Access are needed to use the Add-in.
[bookmark: _Toc467311571]The Air Data Input Process
After water chemistry lab data is received by the Air team from analytical lab, it should be reviewed using the NRM Air Excel Add-in to ensure data integrity.  After review, it can be loaded, using the NRM Workbench in conjunction with the Excel Air Add-in, into NRM Air.
The general workflow for adding data is illustrated in Figure 26.
Figure 26:  Workflow for Loading data into NRM with the Air Data tools
[image: ]
For details of specific tasks, refer to the usage processes (quick guides) section later in this document.
[bookmark: _Toc467311572]NRM Air Excel Add-in Installation
Before using the Air Excel Add-In, make sure you’ve got the latest version.  If you need to update, prior to installation you must uninstall the old version.  For the current version and information on how to uninstall and install the Air Add-in visit the NRM Air Data Tools webpage.
[bookmark: _Toc467311573]How to Check the Version of NRM Air Excel Add-in
To check the version of the Air Add-in installed on your computer, first open worksheet in Excel.  Click on the NRM Air tab and then select the “About” option in the control group (Figure 27: NRM Air Tab).
Figure 27: NRM Air tab
[image: ]
Clicking on the About option will open a dialog box with the current version information of the Air Add-in installed on your computer.
Figure 28: NRM Air Excel Add-in version information
[image: ]
Check this version number with the most current version available on the NRM Air Data Tools webpage, under the section titled “Install New Version of the NRM Air Excel Add-in.”  If the version on your desktop is older follow the “Uninstall Previous Versions” and the “Install New Version” Instructions found on this webpage.
Figure 29: NRM Air Data Tools webpage
[image: ]
[bookmark: _Toc467311574]Getting Started with the NRM Air Excel Add-in
[bookmark: _Toc467311575]Select Trusted Locations
Prior to working in the Add-in you must configure your “Trusted Locations” in Access.  You only have to do this once.  If you don’t configure Trusted Locations, you may get this error when you Link Tables using the Add-In.
Figure 30: Error Exception Occurred message
[image: ]
1. Open the Access application to an active or blank database.
2. Select the FILE tab and Options (on the left), this will open the Access Options window.
Figure 31: Access Options window
[image: ]
3. Select Trust Center and then “Trust Center Settings…” – this will open the Trusted Locations window.
Figure 32: Trust Center Settings button
[image: ]
4. Review the list of trusted locations to make sure your “Documents” folder path is there.  If not select “Add new location…” at the bottom of the window.
Figure 33: Trusted Locations list; Add new location button
[image: ]
5. The Trusted Location Browser window will open.  Click on the Browse… button, navigate to and select your “My Documents” folder and click OK.  Next make sure to check the box next to “Subfolders of this location are also trusted” and click OK.
Figure 34: Trusted Locations Browse button
[image: ]
6. Finally click OK on each open window to complete the process.
[bookmark: _Toc467311576]Activating the NRM Air Excel Add-in
Each time want to use the NRM Air Excel Add-in, you will need to activate the Add-in by selecting the NRM Air Tab and then clicking the check box next to Water Chemistry Lab Data.  This will open all the tools or “groups” available in the add-in (see Figure 35: NRM Air Excel Add-in).
	
	Warning
Before you enable the Add-In, close all open instances of Excel or open a new instance by Alt-right-clicking on the Excel icon on your desktop or taskbar, then select “yes.”  If you don’t have an icon, you can go to Start>All Programs> Microsoft Office 2013.  Hold down the Alt key, then highlight and left click on Excel.  If you don’t do this, every open instance you have of Excel will get a Lab Data page at the start of the workbook.


You will get a dialog box either way asking if you want to start a new instance.  Click on Yes.
Figure 35:  Opening a new instance of Excel
[image: ]
[bookmark: _Toc383157364]Figure 36: Enabling NRM Air Excel Add-in
[image: ]
	
	Note
If you haven’t already, you will be prompted to save your file before activating the Air Add-in.


[bookmark: _Toc383157365]Figure 37: Workbook is Not Saved warning message
[image: ]
When the Air Add-in is enabled in a new workbook, the following actions occur:
1. A helper Access database is created and saved to the same location as the workbook.  The name of this file is has the name of the Excel workbook, appended with “Helper.accdb”.
2. A custom XML part is added to the Excel document for keeping track of variables specific to each workbook.
A new worksheet, named LabData, is added to the workbook.
[bookmark: _Toc467311577]Link Tables
The first step after enabling the Add-In is to use Link Tables in the Server Group to associate the spreadsheet with AirWaterChemistry.mdb file downloaded earlier using the NRM Workbench.
[bookmark: _Toc467311578]Air Add-in Menu Groups
The Air Add-in is divided into four Menu Groups (Figure 38), each having different functions.  these Groups are labeled: “Lab Data,” “Analysis,” “Server,” and “Control.”
Figure 38: NRM Air Excel Add-in menu groups
[image: ]
	
	Note
When enabling the Excel Add-in, the functionality are available according to he location where the workbook is being used (i.e., Forest Service (FS) computer system or a non-FS/external lab computer).
· If the computer is not a USDA FS system, then it has limited functionality.  Only the “Lab Data menu group will be available in this case.
· When the system is a FS computer, the “Lab Data,” “Analysis,” “Server,” and “Control” menu groups are available when the NRM Air Add-in is enabled.


[bookmark: _Toc467311579]Lab Data Group
The Lab Data group allows you to work with the data in the LabData worksheet using standard forms.  You are not restricted from editing the information in the worksheet directly, but in order to get valid values for many of the fields and not create unnecessary duplicates, it’s best to use the forms available through the Samples and Measurements menus. The actual measurement values will need to be entered directly in the Excel LabData worksheet.
First, select the Geographic Extent of the dataset.
	
	Warning
If your dataset has data from more than one extent, you will need to split it and load the data from one geographic extent at a time.


Figure 39:  Selecting the Extent
[image: ]
[bookmark: _Toc467307364][bookmark: _Toc467311580][bookmark: _Toc464471598][bookmark: _Toc464631894][bookmark: _Toc466971834][bookmark: _Toc467157354]Samples
The Samples section provides basic forms to make sure you select the appropriate, existing values in NRM Air rather than creating new duplicate values where you don’t mean to.  More details follow, but there are separate forms for Water and Deposition samples and slight differences for creating new samples vs editing existing sample records where you’ve already copied data into the worksheet.
[bookmark: _Toc464471599][bookmark: _Toc464631895][bookmark: _Toc466971835][bookmark: _Toc467157355][bookmark: _Toc467307365][bookmark: _Toc467311581]Measurements
Use the Measurements > Add Standard Set to add the headers for the major anions and cations, pH, conductivity, and acid neutralizing capacity.  Do this BEFORE adding additional measurement parameters.  The standard set of measurements will be added in columns immediately to the right of the Sample data columns.
Make sure to use the original Units of Measure (UOMs) from the lab for all data when loading into the Air database.
Figure 40:  Adding the Standard Measurement Set to the Worksheet
[image: ]
If your dataset has additional measurements, click in the column to the right of the standard measures, then select the “New…” option in the Measurements menu to add additional analytes.  You can also edit existing analytes to change the unit of measure, measurement type, analysis location type, detection limit, etc. through the “Edit…” option of the Measurement section.
Figure 41:  Measurement Definition Form
[image: ]
[bookmark: _Toc467307366][bookmark: _Toc467311582]Format
Format > Re-apply Formatting applies the original Air Add-in formatting to the workbook.  Use this if you think you may have changed the Add-In formatting in error.
	
	Note
To avoid errors, it is a good idea to re-apply formatting prior to loading data into the AirWaterChemistry.mdb.


[bookmark: _Toc467311583]Analysis Group
The Analysis Group provides tabular and charting analysis functions for examining lab data.
[bookmark: _Toc464471601][bookmark: _Toc464631897][bookmark: _Toc466971837][bookmark: _Toc467157357][bookmark: _Toc467307368][bookmark: _Toc467311584]Tabular Functions
Group into Standard Set: used after retrieving data from an export from the NRM Air database.  This function will add columns with merged analytes sharing the same measure type and unit of measure, ignoring the equipment type, and the detection and quantification limits.  You can then use these grouped measurements together for analysis.
	
	Warning
Use this function only if you understand the analytical implications of grouping parameters together that have different detection limits or analysis methods.


Figure 42:  Analytes columns in Excel before and after being merged into an Analysis Group
[image: ] [image: ]
	
	Note
The process of being merged into an Analysis Group collapses multiple columns into one.  In the example in Figure 42, all of the Potassium-related columns on the left are merged into on in the figure on the right.


· Add Cell Formulas (Standard Set Only): This function adds cell calculations for major cations/anions to convert them from milligrams per liter to microequivalents per liter so that the standard cation/anion balance quality check can be run on the samples.
· Compare Replicates: this function makes a copy of the Lab Data worksheet, sorts the data, and groups sample rows that are replicates to facilitate the quality assurance procedure of checking the relative standard deviation of replicate samples.
[bookmark: _Toc464471602][bookmark: _Toc464631898][bookmark: _Toc466971838][bookmark: _Toc467157358][bookmark: _Toc467307369][bookmark: _Toc467311585]Chart Functions
· Chart Sets: provides the capability to create and run predefined sets of charts.  Histogram, Scatter, and Box-Whisker chart types are available.  Chart Sets are saved in the workbook file when the Excel document is saved.  They can be exported, then imported into other workbooks from the Charts Set menu.
· Time Series Plots (with selected columns): for each measurement column that has a cell selected, will create a scatter chart worksheet with the Sample Collected Date as the X Axis.
· Delete All Chart Worksheets: this function removes the worksheets that have charts on them.  Worksheets that may have failed to generate a chart will need to be deleted manually.
[bookmark: _Toc467311586]Server Group
This group contains the functionality for working with the Air Water Chemistry Access database template (AirWaterChemistry.mdb).  The following capabilities of this group are:
· Link Tables opens a dialog box that allows you to select a specific Air Water Chemistry Access database (saved in a trusted location) to populate and/or read data from.
	
	Warning
By default, the link is to the AirWaterChemistry.mdb database located in the installed folder (C:\fsapps\fsprod\NRM\NRM Air Excel Addin\Workbook\AirWaterChemistry.mdb).  Do NOT use this default!


· Load/From Excel… starts the process of loading the data from the Excel Add-in Lab Data worksheet to the Air Water Chemistry Access database linked to the workbook.
	
	Note
Load > From NPSTORET… is not working due to a data change format.


· Retrieve/All… reads the data from an exported AirWaterChemistry.mdb file used to export data from NRM and populates the LabData worksheet.  The AirWaterChemistry database must be Linked to the workbook.
[bookmark: _Toc467311587]Control Group
The Control group provides functions to manage the Air Add-in:
· About opens an information dialog with the version and a short description of the NRM Air Excel Add-in.
· The Water Chemistry Lab Data checkbox allows you to enable/un-enable the NRM Air Add-in within the current workbook.
· The Helper Database provides the ability to locate or generate a new helper database if the workbook gets renamed or moved to a different folder.
[bookmark: _Toc467311588]Sample Definition Form
The Sample Definition Form is used by analytical labs or air specialists for data entry.  A row is created in the spreadsheet that contains all of the information entered into the form.  Access the form from the Lab Data group by clicking on the arrow for Samples and selecting either Water or Deposition.  You will see the same form whether you choose New… or Edit…, however when you select Edit…, the form will be filled in with information based on the row highlighted in the spreadsheet.
[bookmark: _Toc383157367]Figure 43: Water Sample Definition form
[image: ]
All fields with titles in bold and underlined are required fields which must be filled in prior to clicking on “OK” and saving the sample.  All fields with titles in bold (with no underline) must be completed to meet the National Air Program protocols.
Some fields may have data copied into them or typed in, while others have drop-down lists from which you choose values from the Air database.
[bookmark: _Toc383157368]Figure 44: Sample ID field
[image: ]
[bookmark: _Toc383157369]Figure 45: QA Sample Type drop-down list
[image: ]
There are date fields that include an arrow so you can display a calendar to select the date from, as shown in Figure 46.
[bookmark: _Toc383157370]Figure 46: Drop-down calendar function
[image: ]
And, finally, there are fields which have a “Select” button next to them that brings up longer lists such as Monitoring Sites associated with a Monitoring Project, as shown in Figure 47.  The first time you click on the Select button in the form, it can take a while to load the selections.  Subsequent times will be much faster.
[bookmark: _Toc383157371]Figure 47: Site Name field
[image: ]
The Record Selection Dialog form provides the ability to quickly find the record you’re looking for.  In the “Scroll To” field, type in the name or the first few letters such as, “Diamond”, shown in Figure 48. After you have found the correct record, click on the name of the record to highlight it and then click “OK”.
[bookmark: _Toc383157374]Figure 48: Record Selection Dialog window
[image: ]
If, at any time while editing the Sample Definition form, you want to clear out all of your changes, simply click on the “reset form” button in the lower right corner of the form.
[bookmark: _Toc383157376]Figure 49: Sample Definition form – Reset Form
[image: ]
[bookmark: _Toc467311589]Navigating Data in the Workbook
[bookmark: _Toc467311590]Data Columns
All data columns have a format defined.  Columns with numeric data are limited to five significant digits.  Don’t change the formatting of the data.  Take extra precaution to only copy values, not formats, when cutting and pasting data into the Lab Data.
[bookmark: _Toc467311591]Sample and Measurements Hide/Show Detail
You can use the Sample and Measurements/Hide Show Detail options in the Lab Data menu to hide some of the initial columns and a few header rows  to make it easier to work with the worksheet.  Don’t Hide them until you make sure all mandatory columns are populated and you know the measurements have the detail you want.  Once the worksheet is set up and data copied in, hiding the sample and measurements details may help you move around in these large datasheets.
[bookmark: _Toc383157379]Figure 50: Set measurements
[image: ]
[bookmark: _Toc467311592]Sorting and Filtering Data
The LabData worksheet has ten header rows.  To sort the rows of sample and measurement data without including the headers, follow these steps:
1. Use the Lab Data group menu Sample > Select All, then click the Excel Data Tab, then click on the Sort Table Icon
2. Leave the “My data has headers” box unchecked and use the “Sort By” in the column labeled “Column” to specify which column in the worksheet you want to sort by
a. Should you wish to sort by multiple columns, use the Add Level function to do so
b. All other options are available for you to specify what to sort on, the order, whether to sort case-sensitive, and top-to-bottom or reverse
[bookmark: _Toc383157380]Figure 51: Sort dialog box
[image: ]
[bookmark: _Toc467311593]Copy & Paste Data in the Air Add-in Template
Frequently, the most efficient way to get your lab data into the worksheet is to copy and paste the rows from your source data into the Add-in worksheet.  There are a couple of things to keep in mind:
1. Make sure to paste only the values copied and not formatted values; cell formatting needs to follow the standard format in the Add-In.
2. To re-apply the formatting to all the cells in the workbook, click on the Format drop down arrow and select the Re-Apply Formatting option found in the Lab Data Group.
[bookmark: _Toc383157381]Figure 52: Format > Re-apply Formatting
[image: ]
	
	Note
If you are copying data from a non-Add-in workbook to an Add-in workbook, make sure you open the non-Add-in workbook in a separate instance of Excel.  (See Activating the NRM Air Excel Add-in section for more details.)


[bookmark: _Open_a_New][bookmark: _Toc467311594]Charting with the Excel Add-in
There are some basic charting functions built into the Add-in.  To access this, click on the Charts button in the Analysis Group.
[bookmark: _Toc383157382]Figure 53: Charts drop-down menu
[image: ]
To begin creating charts, click on the Charts button in the Analysis Group of the Add-in.  Then, click on the Chart Set option, then select Configure….  This opens the Chart Set Configuration window.
[bookmark: _Toc383157383]Figure 54: Chart Set Configuration window
[image: ]
The Chart Set Configuration  window is used to set up the different types of charts that you can re-use.  To set up a new Standard Chart Set, click on the New button.  You will be prompted to provide a name for this new chart set.
[bookmark: _Toc383157384]Figure 55: Please Provide Information window
[image: ]
Enter a descriptive name for the chart, then click OK.  To configure the charting and analysis options you want, select the appropriate values in the Chart Set Configuration form.
Figure 56: Chart Set Configuration
[image: ]
To delete a standard chart from the Chart Set Configuration list, highlight the name of the chart and then click on the Delete button.
Charts you can create include box and whisker plots, histograms, and scatter charts.  The standard chart set includes: NO3(from Column BV), SO4(BX), Conductivity(DA, BM), and Cat-An(CR,CO).
Histogram charts are a visual representation of the distribution of the data selected.  Scatter plots let you see all of the individual points of data so that you can visualize clustering, linear patterns, and outliers.
[bookmark: _Toc467311595]Run Chart Set(s)
To run a chart set, go to the Analysis menu group and click on Charts, then Chart Sets.  Now select Run… to open a dialog box where you select which previously-configured chart set you wish to use.  Click the box next to the Chart Set name to run that chart set.  Multiple chart sets may be selected, however this will increase the amount of time needed to process the data and create the charts.
[bookmark: _Toc383157385]Figure 57: Chart Set Selection form
[image: ]
When you click on OK, the Add-in processes all of the data based on the chart set(s) selected.  A new worksheet is created for each of the charts.  When the process has completed and all selected charts have been generated, you will receive a confirmation box.  Click OK to close this window and review the charts.
Chart worksheets are not created when the measurement parameter column(s) cannot be found.  If the column(s) of a chart are empty, the worksheet is added, but no chart is created.
[bookmark: _Toc383157386]Figure 58: Chart Set generation complete notice
[image: ]
[bookmark: _Toc467311596]Chart Set XML Files
Chart sets can be exported or copied and shared with other users of the Add-in or imported into your own workbook files.


[bookmark: _Toc467311597]Additional Information
[bookmark: _Toc467311598]FAQ and Troubleshooting
[bookmark: _Toc464471619][bookmark: _Toc464631915][bookmark: _Toc466971853][bookmark: _Toc467157372][bookmark: _Toc467307383][bookmark: _Toc467311599]NRM Air Tab not Available
If, when you open Excel for the first time after installing the Add-in, you do not see the NRM Air tab, go to the File tab and select Options.  This opens the Excel Options window, as shown in Figure 59.
Figure 59: Excel Options window
[image: ]
Click on the Add-in button in the left column.  At the bottom of the Add-in window, click on the drop-down arrow next to the Manage field and select Disabled Items.  Then click Go.
The Disabled Items window opens.  Click on NRM Air Add-In, then click OK.
[bookmark: _Usage_Scenarios][bookmark: _Step_3:_Links][bookmark: _Step_3:_Link]

[bookmark: _Processes][bookmark: _Toc467311600]Processes
This section is currently under development.
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